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FROM
TALKING ...

...TO ACTION

Contact information:

WHY WE NEED THE COOLKIT:

Stephen Sheppard

Our communities are changing. How can we understand and manage that change? This Coolkit is
designed to help you:

Professor, Faculty of Forestry, UBC
Forest Sciences Centre, 2424 Main Mall
Vancouver V6T1Z4
stephen.sheppard@ubc.ca

• Learn about your block and how climate change affects
it
• Meet your neighbours and talk to them about climate
change

Zhaohua (Cindy) Cheng

• Improve quality of life on your block

Program Coordinator, Faculty of Forestry, UBC
Forest Sciences Centre, 2424 Main Mall
Vancouver V6T1Z4
zhaohua.cheng@ubc.ca

• Climate-proof your home and neighbourhood
• Cut your carbon footprint together with your
neighbours
• Have fun along the way!

WHO IS THIS FOR?
• Community members wanting to have meaningful interaction with their neighbours in caring
for the places where they live

facebook.com/CoolkitVancouver/

• High school students and youth groups wanting
to get involved
• Practitioners, teachers, librarians, and community leaders running neighbourhood engagement programs

citizenscoolkit
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COOLKIT AT A GLANCE
ACTION
VISIONING
RATING
MAPPING
CONVERSATION

A do-it-yourself process on climate change that gradually
ramps up community engagement in several steps

i

Coolkit introduction
Climate change
Urban forests
Renewable energy

INTRODUCTION
Introduction, climate change, and Vancouver’s
urban forests

START A CONVERSATION
Meet your neighbours, test your knowledge

MAP YOUR COMMUNITY
Get to know your block and see it in a new
way

RATE YOUR BLOCK
Rate how sustainable your household & block
are

VISION YOUR FUTURE
What might your block look like in the future?

ACT ON THE GROUND
Identify priorities, implement strategies

calp.forestry.ubc.ca/
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Story collection
Photo gallery
Photo quiz
Non-trivia quiz
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Urban forest quest
Climate change detective
Carbon visual
Habitat mapping
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Household scorecard
Block scorecard
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High/low carbon future visioning
Before and after comparisons
Home retrofits
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Transportation change
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Make a pledge
Plan ahead
Protect your trees
Beautify your yard/block
Develop a low-carbon lifestyle
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HOW TO USE
Scope
This booklet aims to help you climate-proof your neighbourhood while improving the urban forests that surround
your home. This booklet is full of fun tools and hands-on activities that are organized into 5 steps: chatting, mapping,
rating, visioning and acting. These activities aim to help you see your neighbourhood in a new way, make climate change
visible, and re-imagine your future. Pick the activities that you find the most interesting - or do them all if you wish!

Icons
Individual

Group

Family

Find the icons at the top right corner of each activity guide.
These icons suggest who the actvities are best suited for. Individual activities are suited for one person, while group
activities can be conducted with your family or neighbours. Children may find activities for families fun!

Where can I use the Coolkit?
Most of the activities here are simple, easy, and fun to do with family, friends and neighbours!
Consider introducing the Coolkit at a block party, when spending time with neighbors or friends, or on
Facebook. Don’t forget to bring a copy of the Coolkit along with some pens, markers, and other required
materials.

Block Party

Informal Gathering

A good place to start the conversation and hold introductory games or exercises with your neighbours.

Over coffee, wine, or supper at someone’s home or a
cozy meeting place nearby to discuss further activities.

If it is hard to meet in person, don’t give up! Consider online options such as creating and using a Facebook
group or meeting regularly on Skype. You can also follow us on Facebook (facebbok.com/CoolkitVancouver/) and Instergram (citizenscoolkit) to keep an eye on the upcoming events and share your ideas under
the posts.
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WHY BOTHER ABOUT CLIMATE CHANGE?
CLIMATE CHANGE IS HAPPENING

The main CAUSE of climate change is carbon emissions produced from human
activities (e.g. driving cars, building houses), which adds to the greenhouse effect, trapping
heat and further warming the Earth's surface. Canada has committed to keep global warming
to below 2 °C (relative to pre-industrial levels)1.

WHAT WILL HAPPEN IF GLOBAL
TEMPERATURES RISE MORE THAN

2 °C

Households directly account for 40%
of BC's total greenhouse gas (GHG)
emissions3.

MORE HEAT WAVES

WATER HEATING
AIR TRAVEL

8%

CARS AND TRUCKS

13%

45%

MELTING SNOWPACK
Snowpack in B.C. has been
reduced by HALF over the past
50-100 years6, leading to reduced
water supply & water restrictions

SPACE HEATING
AND COOLING

17%

WASTES

14%

BC has warmed up by about 1 °C over the past
century; daytime summer temperatures will be
warmer by 3.7 °C by 20504. The heat wave in 2009
killed 100 people in Vancouver5

BUS AND RAIL

2%

APPLIANCES AND
LIGHTNING

1%

British Columbia has committed to
reduce its carbon emissions to8:

40% below 2007 levels by 2030
80% below 2007 levels by 2050

calp.forestry.ubc.ca/

MORE FLOODS & DROUGHTS

RISING SEA LEVEL

Hotter, drier summers, & more intense
rainstorms will cause more severe and
frequent floods and droughts6.

Estimated increase of sea level in coastal
BC by 2100 is 1m or more7. We will lose
homes, communities, and ecosystems
(an estimated total damage $30 billion
by 2050)7
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HOW CAN URBAN FORESTS HELP?
What is an urban forest?
The urban forest includes a variety of vegetation and landscape types such as parks, streetscapes, natural areas, and
private yards, which together form a complex system of urban greenery.
A healthy urban forest will be vital in a hotter, unpredictable future to protect human health during heatwaves, reduce our reliance on air conditoning, reduce flooding, absorb carbon, and provide habitat to wildlife. An urban forest
also increases property value and happiness. Our gardens can further help us adapt to climate change by growing
food (reducing reliance of imported produce).

Infograph by Sara Barron

How large is our urban forest?
Vancouver’s urban forest today is made up of:9

140,000 street trees
300,000 park trees
Unknown number of private trees

?

?

?

?

?

?

?

18% of Vancouver is covered by tree canopy, as calculated and mapped by the City:

10

11% of canopy on streets
27% of canopy in parks
62% of canopy on private property
7
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BUT, WE ARE LOSING HEALTHY TREES EVERYDAY,
MOSTLY ON PRIVATE PROPERTY
Vancouver aims to increase tree canopy from

18% to 22% by 2055

through better management and replanting

150,000 trees by 2020

.

10

by Gurtej Tung

"Over the last two decades, 23,490 healthy, mature trees were removed on private properties (including residential,
institutional, commercial and industrial land)"
- City of Vancouver

HOW MUCH CANOPY COVER DOES YOUR NEIGHBOURHOOD HAVE?

Map of tree canopy cover (%) across Vancouver neighbourhoods

WHAT CAN WE DO?
BC's carbon reduction targets and tree planting targets are for all of our benefits; we must do our share to keep to
2°C of warming.
We also need to prepare for the impacts of climate change. We can begin to cut our emissions, for example, by taking better care of trees in our neighbourhood, switching to renewable energy sources, driving less, or switching to
hybrids or electric vehicles, and taking better care of our neighbourhood trees. Flip to the next page to begin the
journey!

calp.forestry.ubc.ca/
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HOW CAN RENEWABLE ENERGY HELP?
What is renewable energy?
Renewable energy is the energy generated from natural processes that is continuously replenished. This includes
sunlight, geothermal heat, wind, tides, water, and various forms of biomass, which will not be exhausted and is
constantly renewed.
Renewable energy will become one of the most effective tools for us to combat climate change as these sources
displace traditional carbon-intensive fossil fuels (the main cause of anthropogenic climate change). Furthermore,
the technologies can save us money and increase job opportunities in the long run.

Learn more about Renewable City Strategies at: http://vancouver.ca/green-vancouver.aspx
Lower energy cost
Reduce electricity bills
Decrease air pollution

Support domestic green jobs

Lower GHG emissions

Provide recreation/ educational values

Improve reliability for future generations

Potential economic and environmental impact of renwable energy

Reycling

Electric vehicles

Hydrogen and fuel cells

Hydroelectricity

Tide & Wave

Wind Power

Solar pannel
by CleanEnergy Fooprints @
UBC’s CALP team has developed a tool called Community Energy Explorer (CEE), which is a web resource, designed to
provide communities and citizens with information and tools for local energy planning and carbon emission mitigation. To
learn more about CEE, please visit: http://calp.forestry.ubc.ca/home/community-energy-explorer/

9
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BUT, THE MAJORITY OF ENERGY WE USE TODAY IS STILL UNSUSTAINABLE
In 2014, 69% of energy used in Vancouver is fossil-fuel derived:

By 2050, Vancouver aims to:
- Derive 100% of the energy used in Vancouver from renewable sources before 205048.

31% building
electricity

- Reduce greenhouse gas emissions by at least

80% below 2007 levels before 2050

31%

.

48

RENEWABLE

by Renewable City Stategy@

69%

FOSSIL-FUEL
DERIVED

45% building
heating
(natural gas)

24%
transportation

How will Vancouver get to 100% renewable energy by 2050?
Buildings
&
Transportation

Fossil Derived Source
(Figures in Million GJ)

Renewable Energy Source
(Figures in Million GJ)

2014
Total Energy Use
59.3 Million GJ

2050
Total Energy Use
38.3 Million GJ

Double the use of renewable energy

1% Hydrogen
10 % Biomethane
14% Biofules
15% Neighborhood
Renewable Energy Systems

1% Biofules
30% Electricity

Reduce the Energy Demand
Inrease Renewable Energy Use
Increase Renewable Energy Supply

60% Electricity

20% Diesel

46% Natural Gas

Elliminate fossil-fuel use

Present

2050

Why do we need renewable energy? Renewable energy sources diversify and localize energy supplies, emit little or no
carbon into the atmosphere, and lower the costs of buildingmaintenance. They are also less detrimental to human health than
fossil fuels49.
Why does Vancouver aim to achieve this goal? Metro Vancouver, has massive capacity (rich in natural resources such
as wind power, hydrology and biomass) to provide its own renewable energy within the borders, but this potential is currently
barely utilized. As cities continue to grow, we must look at local sources of heat, cooling, and electricity that are sustainable in
calp.forestry.ubc.ca/
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STEP 1: START A CONVERSATION

Now that you know how important climate change and urban forests are to the future of our city, it’s time
to share that knowledge with your family, friends, and neighbours. Here we provide some activities to help
you start a conversation with others on climate change and urban forests.
1. COLLECTING STORIES about changes that have happened on your block over time
2. PHOTO GALLERY to discuss changes on your block
3. PHOTO QUIZ to look for signs of climate change on your block
4. NON-TRIVIA QUIZ to test your knowledge on urban forests and climate change

11
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START A CONVERSATION
STORY COLLECTION
Why do this? To recognize how much your neighbourhood has changed over the past decades, through changes
in urban development, lifestyles, tree growth, and climate change impacts.

Collect stories of the changes that have happened on your block:
More greenery or less greenery? Smaller houses or larger houses? Changes in weather patterns? More cars or less
cars? How do you feel about this?

You will need:
•

1-2 hours

•

Grab a pen and a notebook

•

Spend a pleasant afternoon with your relatives or
your neighbour(s) who have lived in the area for
a while

•

Record the stories you hear and what you see

•

Share your collections online.
Photo by Joshua Ness on Unsplash

STORY #1 (example):

STORY #2 (write down your own story here) :

calp.forestry.ubc.ca/
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START A CONVERSATION
PHOTO GALLERY
Why do this? To recognize things you value around your block and how they relate to climate change.

PHOTO GALLERY HOMEWORK
ASSIGNMENT
Each person/family takes a picture of:
1. Their favourite place or view on the block
2. Their favourite tree on the block
3. Something on the block that they connect to
climate change
Option: Collect old photos of the block to compare
changes over time

OPTION 1: A photo gallery

OPTION 2: An online album

1-1.5 hours

1-3 hours, depends on how many photos and how often you
update

Bring prints of photos into a room or public location
with a bulletin board. Display your photos for all to
see, and have each person describe their own photos.

Several options exist for making free online photo
albums, such as Facebook, Flickr, or Instagram.

If easier, keep a scrapbook or 3-ring binder of all
photos - portable and easy to store!
What do you notice?

WHAT TO DO NEXT:
After reviewing the photos, discuss what you learned and decide if you want to compile the photos and
findings into an album that can be shared by meeting in person, or via email, Facebook, or Skype.
* This follow up session would be a great time to complete the Photo Quiz on page 14-15!

13
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START A CONVERSATION
PHOTO QUIZ
Why do this? To find signs of climate change in your block.
Here we are looking for signs of “CIMA”.

C
I
M
A
Examples of what to look for
Consider potential impacts based on possible threats in different seasons, or what activities related to mitigation or
adaptation could potentially take place. For instance, as seen in the photo below, mature trees can be a potential impact if
they are unhealthy and blow down in wind storms, but are more often an adaptation against the effects of climate change
by reducing the impacts of heat waves and stormwater floods.

Recognizing climate change in the neighborhood: West 13th Avenue near Maple street
Causes
Automobiles
Concrete (production)
Heating - natural gas/wood burning
Home energy use

Potential impacts
Increased home cooling costs
Tree decline/death
Tree failure - damage to property
Drought - water restrictions

Mitigation

Adaptation

Car pool or car-share

Plant trees for shade & insulation

Limit use of automobiles

Grow a vegetable garden

Travel by bike or on foot

Plant drought resistant plant varieties
Example: Planter box on W. 14th Ave near Maple

calp.forestry.ubc.ca/
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PHOTO QUIZ SHEET
YOUR NAME:
You will need:
•

30 minutes

•

Pick 3 photos to examine

•

For each photo of your block, write down which of the CIMA (page 14) features you identify

•

Add a small version of each photo to place next to the description if you like

•

Use your photos to quiz each other on signs of climate change on your block

PHOTO #1
SAMPLE PHOTO

1
PHOTO #2
SAMPLE PHOTO

2
PHOTO #3
SAMPLE PHOTO

3
Compare your results with other group members:
•

Did anyone see an actual impact of climate change in the photos?

•

Did anyone see what is the biggest vulnerability around the block?

•

Did anyone see visible adaptation taking place in the photos?

•

Would you consider your block a high or low carbon area?
15
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START A CONVERSATION
NON-TRIVIA QUIZ
YOUR NAME: 			
You will need:
•

30 minutes

•

Read the Cookit package to answer questions 1-4

•

Walk around your block and search for answers online for questions 5 & 6
The questions below are just examples - feel free to come up with your own that match the interests and
issues in your own community. Once complete, discuss the answers with the group. Hold a trivia quiz
activity at someone’s home or a community event, and share answers.

1. What is BC’s 2050 carbon emissions reduction target?

2. What produces the most carbon emissions from households in BC?

3. What is the average carbon footprint of residents in BC?

4. How many trees is Vancouver planning to plant from 2010 to 2020?

5. What kind of tree provides the biggest canopy on your street?
6. Are there any trees on your street that are native to your region (coastal BC)?
If yes, what kind?

calp.forestry.ubc.ca/
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STEP 2: MAP YOUR BLOCK
Do you know much about the trees on your block? Have you ever tried to inventory
important things on your block and consider their links to climate change? Do you live on a high carbon
or low carbon block? The activities in this section will help you see your surroundings in a new way, and
learn to use some simple mapping techniques.
1. URBAN FOREST QUEST allows you to investigate “squirrel habitat” (tree canopy) and other
features of your urban forest

2. CLIMATE CHANGE DETECTIVE QUEST allows you to investigate “car habitat” and other signs of
climate change

3. MAP DIFFERENT HABITAT TYPES in your block to see how green or grey it is and where it could be
improved

4. VULNERABILITY MAPPING allows you to find parts of your block which would be under the greatest threat from climate change

17
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MAP YOUR BLOCK
URBAN FOREST QUEST
DO YOU KNOW...
How much squirrel habitat is on your block?
How many trees there are on your block?
Why trees are important to us and squirrels?

30 minutes

Your name/team name

1) COUNT THE TREES
Street trees are trees alongside the curb in the public
right-of-way. Count the number of street trees on your block.
6

5

4

2) MEASURE TRUNK SIZE
1

2

3

Total # of street trees:

Measure the circumference (girth) of the biggest
and smallest trees. At around 1.3 metres (or 4.5 ft) up
from the ground, measure around the tree’s stem.

Total # of trees in gardens:

Girth of biggest tree:
Girth of smallest tree:

cm
cm
1.3 m

3) THE LEAPING SQUIRREL TEST
Check out your block’s street tree canopy by using the distance
a squirrel leaps. Squirrels live up in the trees and are safer there
than on the ground. Assume squirrels can leap about 2 metres
(6 ft or a person’s height) between branches:

Important because...
Larger trees have bigger canopies and so
more benefits. Smaller trees are also important since they will replace existing big trees
one day.

Can a squirrel make it from one end of the block to the other and
cross the street at least twice, without coming down to the ground?
Yes / No
If “No”, how many gaps (greater than 2 metres)
between canopies did you see?

Important because...
A continuous canopy has more shade
during the summer for cooling and reduces stormwater flooding.
To read more: http://forestry.ohiodnr.gov/

portals/forestry/urbantoolbox/articles/BigTrees_
SEOhio.pdf

FINISHED!
calp.forestry.ubc.ca/

18

MAP YOUR BLOCK
CLIMATE CHANGE DETECTIVE QUEST
DO YOU KNOW...
30 minutes

Your name/team name

How many carbon-emitting cars park on your block?
How much local food is grown on your block?
Whether your roof is suitable for solar panels?

CASE 1: TRANSPORTATION
Difficulty

Total:

1. How many cars are on your block?

2. How many cars are electric, hybrid vehicles, or carshares (eg. Modo)?
*% of sustainable cars on your block:

Total:

Simply divide your Q2 answer with Q1!

Total:

Ex. If Q1 is 8 and Q2 is 2: 2/8 = 1/4 = 0.25

3. How many people are riding bikes in /through your block?

se...
nt becau r diesel aca
t
r
o
p
Im
soline o
-

ld emis
using ga
Vehicles 47% of househo
r
count fo .
C
B
in
s
n
sio
: suzuki.org/issuoelus/d more
avid
To re:/a/w
.d
w
/climate-s
http te-cwhange/scien-scoelutions/
clima ransportation
tions/t

Total:

CASE 2: FOOD
Difficulty

How does local food
help
climate change?
Carbon emissions come
from meat
production, use of pestici
des and fertilizers, and the transportati
on of food.

To read more:

http://www.davi zuki.or
g/what-youcan-do/food-anddsu
-our-planet/

1. How many households have gardens (planted areas with shrubs and/
or trees) on your block? (If gardens are out of sight, try asking your neighbours!)
Front yard:		

Backyard:		

Total:

2. How many households are growing food (vegetables, fruit...)?
*% of food gardens on your block:
Divide your Q2 answer with Q1!

Total:
Total:

3. What is the most commonly grown vegetable on your block?
CASE 3: SOLAR ENERGY
Difficulty

1. How many buildings have solar panels on their roofs?
Count the number of buildings with solar panels.
2. How many buildings have roofs suitable for solar energy? Count the
number of buildings with south-facing roofs large enough for solar
panels.

You’ve cracked
all the cases!

N

*

* This side faces South

Roof

19
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MAP YOUR BLOCK
CARBON VISUAL QUEST
DO YOU KNOW...

Your name/team name

How much carbon dioxide is emitted in your neiborhood?
How much carbon is absorbed ?
Do you want to know how big your carbon footprint ?

30 minutes

se...
ual
nt becau
a
t
r
o
ian asnnper
p
d
a
n
Im
a
C
e
ion

Q1. CARBON EMISSION

iss s, comrag
The anve dioxide eetm
ton
ic
r
ur
o
m
b
r
0
ca
ere 2 rld average of fo
w
n
o
s
r
e
p d to a wo
pare
tons.
/
more:.theguardian0.c0o9m
/
To resa:/d/w
2
w
/
w
g
http onment/databisloenvir 2/carbon-emcapita
sep/0-per-personsions

Please go to this website https://www.carbonfootprint.com/calculator.aspx and check your
own carbon footprint!
1) what is the household footprint in one year?
(based on the family electric bills)
2) what is the carbon footprint of your daily transportation
within one year?

Q2. CARBON ABSORPTION

3) what is the total carbon footprint of your
family per year?

Calculate the amount of carbon dioxide absorbed by the trees around your home/school
or along your street. A tree can absorb approximately 48 pounds of carbon per year.

Q1+Q2 (add all the transportation modes)

1) how many trees in your property?
Front yard:

Q3. CARBON VISUALIZATION

Back yard:

Street:

Total:

2) How much carbon dioxide can those trees absorb
se-

Learn more about what trees absorb the most
carbon dioxide:
https://www.hunker.com/12557632/
what-trees-absorb-the-most-carbondioxide

26’8’’

Important because...

Draw your own carbon picture here
(You can take extra paper if you need more space)

Carbon emiss s, air
pollutio
and other enion
onmental ‘invis-n
ibles’ need to vir
be
see
n.
our images an films We want
to be use
and shared as dwid
ely as possibled.

To read more:

http://www.carbonvisuals
.com/resources/

calp.forestry.ubc.ca/
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You have completed your urban forest and climate change detective quests.
Share this completed form with others and see how you did!

Think about your urban forest quest results a bit more...
1. Are there enough trees on the block?
2. How old do you think that big tree is? How much longer do you think it will live?
3. Why is safe squirrel habitat (tree canopy) important to us, not just squirrels? What
do large trees give us?
4. What would it look like if all the trees were gone?
5. How can these trees survive droughts like the one we had in 2015? Do they need
our help?

Think about your climate change detective quest results a bit more...
1. Are people using sustainable forms of transportation such as bicycles, carshares,
or electric vehicles?
2. How can growing your own food help mitigate and adapt to climate change?
3. Did you see any homes with solar panels on your block? Would your house be
suitable for solar panels?
4. How could roads and alleys surrounding your block affect air temperature in the
summer? List two ways trees can help to reduce temperatures.

Think about your carbon visual quest results a bit more...
1. Do you feel suprised about the carbon visual image? Why?
2. What would it look like in 5/10 years? What methods can you think of to make the
size of this carbon cube smaller?
3. Are you interested in global carbon offset options (e.g. reforestation in Kenya or
UK tree planting )? List the activities that you are interested in.
background image by Clker-Free-Vextor-Images: https://pixabay.com/p-42963/?no_redirect

21
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MAP YOUR BLOCK
HOW TO MAP
Mapping is a great way to identify issues and resources in your neighbourhood by helping
you think in a bigger picture. There are also many things you can map on your block. In the
Coolkit, we introduce two mapping exercises:
1. VULNERABILITY MAPPING to find areas prone to impacts of climate change - page 25
2. HABITAT MAPPING to explore different habitats on your block - page 23

Mapping Tools
Method 1: with markers (easiest and quickest)
1. Identify areas on the map as the habitat that you would like to map
2. Colour in parts of your block with different colours to show different types of habitats
3. Think about your results, and what you could do to help improve conditions for the
future - show your neighbours and discuss

Method 2: with Google Earth

Method 3: i-tree Canopy

(simple mapping and visualization)

(Simple and more complete measurement of
different land covers and benefits of trees)

Page 65 (in the Appendix)

Page 66 (in the Appendix)

calp.forestry.ubc.ca/
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MAP YOUR BLOCK
HABITAT MAPPING
Why do this? To quickly identify different types of “habitats” or surfaces in your neighbourhood.

You will need:
•
•

0.5-1.5 hours
Several colourful markers and satellite photos of your block/yard for mapping. Depending on the mapping
tools you use, you will need a computer or some hard copies of photos (you can print them on regular paper
instead of photo paper. Recommended size: 11” by 17” or 18” by 24”

What is habitat mapping?
There are many different habitats (other than human habitat) on your block. Here are some examples of different
habitats that you can map in this exercise:
An example of habitat mapping using Google Earth - please see the Appendix page 65 for detailed instructions

“Squirrel Habitat” - Trees & Canopy
Now that you have an idea of how safe it is for squirrels on your block
after the Urban Forest Quest (page 18), examine all the trees on your
neighbourhood map and figure out how much canopy cover you have.
Urban tree canopies have many important benefits, such as lowering
temperatures and reducing storm effects.

30% of total area
is squirrel habitat

“Worm Habitat” - Lawns & Soil
These soft pervious surfaces allow water to pass into the ground, reducing the flooding and amount of contaminants entering streams all at
once. Soil provides important habitat for many types of underground
creatures, and space for trees, plants, and fungi to grow.

35% of total area
is worm habitat

“Car Habitat” - Hard pavement
Pavement is an impervious surface, which forces stormwater into sewers
or pipes rather than into the soil. This can result in chemicals from the
road entering streams and heavy water flow damaging stream banks.
Roads and parking lots also take up a lot of space and increase temperatures.

20% of total area
is car habitat

“Pigeon Habitat” - Buildings & Roofs
These hard surfaces also affect storm water drainage, often directing
rainwater straight into to the drains and not to the plants which need it
during droughts. Roofs can also provide space for solar panels or green
roof installation, which can help mitigate and adapt to the effects of climate change.

23

45% of total area
is pigeon habitat
calp.forestry.ubc.ca/

Use this sheet to record the percentages of different habitats from Google Earth and/or i-Tree (to find the
percentage of habitats, please see the Appendix “Calculating the area of a polygon”).

RESULTS for habitat mapping
_________% of your block & _________% of your yard is squirrel habitat (tree canopy)
_________% of your block & _________% of your yard is car habitat (hard paving)
_________% of your block & _________% of your yard is ___________ habitat
_________% of your block & _________% of your yard is ___________ habitat
_________% of your block & _________% of your yard is ___________ habitat
Note: try to aim for rough estimates, and don’t strain yourself to get precise results!

Think about your Google Maps/Earth results a bit more...
Which habitat had the highest %? Which had the lowest?
18% of Vancouver is covered by tree canopy. How does this compare with your block?
Are there any findings that surprise you?

Think about your i-Tree results a bit more...
What was the proportion of all of your classes? Was this surprising?

Are there any connections between the maps you created?
How are the habitats related to climate change? Which are causes and which are impacts? And are any
influenced by climate change?

calp.forestry.ubc.ca/
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MAP YOUR BLOCK
VULNERABILITY MAPPING
Why do this? To quickly identify possible risks to the neighbourhood from climate change.

You will need:
•

1-1.5 hours

•

Coloured pens and a paper print-out of an aerial photo of your block (VanMap or Google Earth)

What is vulnerability mapping?
Vulnerability mapping shows the areas which may be susceptible to damage from environmental or manmade
threats, such as climate change. This type of mapping can help you think differently about the kind of risks that could
affect your block and help you label things you may want to change26. This is a simple mapping exercise in which you
will identify high and low risk areas of your block based on one or more climate change threats of your interest.

Procedure (see detailed mapping instructions in the Appendix Page 65):
1.
2.
3.
4.
5.
6.

Print out an aerial photo of your block (8.5x11 landscape)
Choose one or more risk features from the diagram below such as urban heat island effect (UHI),
drought, or floods. Refer to page 6 for climate change risks likely to occur in Vancouver
Identify parts of your block that would be most susceptible to these threats
Identify parts of your block which would be least susceptible to these threats, such as dense canopy, white roofs, and pervious surfaces - refer to page 23 for descriptions of these surfaces
Colour in or mark high and low risk features with your own colours or symbols
Think about your results, how vulnerable your block is, and what you could do to help improve
conditions for the future

Low Risk Features

High Risk Features

Dense canopy

Reduces runoff/flooding,
creates shade

Unshaded south facing home
Exposure to more summer heat

Pervious surfaces

Pavement

Reduce surface runoff/flooding
Store water

Absorbs heat: more UHI
Increases surface runoff

No trees/all lawn

Increases risk of drought

White roofs

Dark roofs

Reflect more heat

Absorb heat: more UHI

Poor drainage

Increases risk of flooding
Worse if it’s a low spot

Aerial photo of a neighbourhood block with some high and low risk features labeled
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MAP
MAPYOUR
YOURBLOCK
BLOCK
VULNERABILITY
HOW TO MAP WITH
MAPPING
MARKERS
More examples of high & low risk features to map
Hint: Walk around the block, or look at Google Earth/Map
Street View to see conditions on the ground

HIGH RISK: Drought
In this photo
Drought intolerant species

HIGH RISK: Heat Island Effect (UHI)
In this photo

Other subtle features to look for

Pavement & concrete

Tall buildings in dense cities

Absorb more solar heat
Reduce evapotranspiration

Dark surfaces (e.g. roads, roofs)

Trap more heat through the absorption
and reflection of sun on multiple surfaces
Block cool air flow

High sun exposure

Especially south and south-west facing areas

Require frequent watering (e.g. turf grass)
Human modified soil
Consider summer water restrictions
Soil in built environments is often
shallow and eroded
Low precipitation/dry season
Holds less water
Especially July-August in Vancouver

Absorb more solar heat

LOW RISK Cooling effects, storm water mitigation
In this photo

HIGH RISK: Flooding
In this photo
Pavement & concrete

Reduce storm water infiltration

Low laying/flat areas

Can overfill with storm water

Poor drainage

Large trees growing together

Other features to look for

Cool the air (evapotranspiration)
Insulate against storms
Reduce storm water runoff

Streams

Can cause flooding if peak
flows exceed surface level

White roofs

Sewers/drains

Pervious surfaces

Reflect heat - reduce UHI
Reduce storm water runoff
Store water
Filter contaminants

Blockages can cause pooling

Causes pooling of water

calp.forestry.ubc.ca/
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Trees near south-facing windows

Provide shade - reduce cooling costs

Other subtle features to look for
Food gardens

Increase foods security
Reduce carbon emissions

Small trees

Will grow and provide more shade
Reduce cooling costs

Solar panels

Reduce carbon emissions

STEP 3: RATE YOUR BLOCK

This section contains two SCORECARDS to let you assess whether your block is prepared for climate change,
and how green it is, by answering some questions about your household and block.
Compare your results with other blocks - and see who has the highest score!

1.

RATE YOUR HOUSEHOLD

2.

RATE YOUR BLOCK

Do you know your
carbon footprint?
We strongly recommend that you find your carbon
footprint so you know your biggest areas of resource
consumption.
Visit http://www.footprintnetwork.org/
resources/footprint-calculator/
(You need an account to access the calculator)
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2
1

b. 50-120 m2

c. >120 m2

1

c. Mostly fossil fuels (e.g. natural gas)

a. More than 1 long-haul flights (generate about 2-4 t of CO2, that’s above the global average

1

c. One short range flight or none

2
1

b. 30-60%

c. <30%

2
1

b. 30-60%

c. <30%

/15

SUBTOTAL

3

a. >60%

5. % of trips by foot/bike/bus in one week:

3

a. >60%

4. % of your house shaded by trees in your yard or block in summer:

2

b. One long-haul flight or 2-3 short range flights

carbon footprint)

3

2

b. Combination of renewable energy and fossil fuels

3. How many flights do you take in a year

3

a. Mostly renewable energy (e.g. solar, hydro, air-sourced heat pumps)

2. How do you heat/cool your home?

a. Light (reflecting heat)

3

a. <50 m2

1

c. I don’t grow any of my food

/15

SUBTOTAL

2

b. I can find some carrots and a potted mint plant

Add up the points. A higher score indicates more
climate-proofedness. Your subtotal score for adaptation at
the household level is:

3

a. I can make a green salad for an entire week

10. How much of what you eat do you grow by yourself?

1

2

b. 20-40%
c. <20%

3

a. >40%

(Refer to page 23 for more information on the different habitats)

1

c. 0

9. How much green or pervious area (‘worm habitat’) is on your entire lot?

2

3

1

2

3

1

2

3

b. 1-3

a. >3

8. How many mature trees are on your property?

c. Garden fully irrigated with tap water

b. Part of the garden is irrigated with tapwater

a. Using roof rainwater capture (waterbutts) and rain gardens

7. How do you use and store water for you gardens?

c. Dark (absorbing heat)

b. Medium

6. What colour is your roof?

IMPACTS & ADAPTATION

CLIMATE CHANGE

RATE YOUR HOUSEHOLD

1. How much floor area for heating and cooling per person is in your home?

CAUSES & MITIGATION

CLIMATE CHANGE

RATE YOUR HOUSEHOLD

Add up the points. A higher score indicates a lower
carbon footprint. Your subtotal score for mitigation at the
								
household level is:

28 28

29 29

2
1

b. Multiple units on each lot (e.g. duplex, townhouse, coach-house)

c. Single family homes

2
1

b. 20-40%

c. <20%

2
1

b. 20-40%

c. <20%

b. 1-2
c. None

2
1

b. Fair distance (15-30 minutes of walk)

c. Very close (0-15 minutes of walk)

2
1

b. 20-40%

c. <20% (little connected squirrel habitat)

/15

SUBTOTAL

3

a. >40% (check page 18 for the ‘leaping squirrel quest’)

1

c. <20%

/15

SUBTOTAL

2

b. 20-40%

Add up the points. A higher score indicates more
climate-proofedness. Your subtotal score for adaptation at
the block level is:

3

1

2

3

1

2

3

a. >40%

10. % of homes growing food (visible from the street):

a. 3 or more

9. How many rain gardens and/or swales are on your block?

c. >60%

b. 30-60%

a. <30%

3

5. What is the amount of tree canopy on your block?

1

2

3

1

2

3

8. What is the overall extent of impervious surface (grey car & pigeon habitat)?

c. No (stunted, dried out, thin foliage)

b. Somewhat/mixed

a. Yes (vigorous growth, dense foliage)

7. Do the trees on your block look healthy?

c. Very few trees are on my block

b. Mostly small ornamental trees

a. Mostly large & mature trees

6. What type of trees are on your block?

a. Very far (over 30 minutes of walk)

4. How far is your house to the closest public transit (e.g. bus) or local shops?

3

a. >40%

3. % of cars on your block that are EVs, hybrids, or car-shares:

3

a. >40%

2. % of homes on your block using solar panels:

3

a. Multi-story apartment

1. What is the most common house type?

IMPACTS & ADAPTATION

CLIMATE CHANGE

CLIMATE CHANGE

CAUSES & MITIGATION

RATE YOUR BLOCK

RATE YOUR BLOCK

Add up the points. A higher score indicates a lower
carbon footprint. Your subtotal score for mitigation at the
								
block level is:

calp.forestry.ubc.ca/

RESULTS for habitat mapping

_

TOTAL for HOUSEHOLD

/30

Add up the subtotals and write the number on the right

TOTAL for BLOCK
Add up the subtotals and write the number on the right

/30

Think about your household results a bit more...
Were you surprised by your score? How does it compare with other households on your block?

Is there any action you could do or avoid immediately?

Is there obvious potential for further reducing your carbon footprints and climate-proofing?

Think about your block results a bit more...
Is this a high or low carbon neighbourhood? Were you surprised by your score?

How does it compare with other nearby blocks?

Is there obvious potential for decreasing your collective carbon footprint and adapting to climate change together?

calp.forestry.ubc.ca/
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STEP 4: VISION
YOUR FUTURE

STEP 4: VISION YOUR FUTURE

Now that you know more about your block and home, you might have some ideas about making some improvements in your own property. In this section, we will provide examples of visioning what you can do for your home
and neighbourhood, with real-life and hypothetical examples - you can also try making your own “dream scenarios”
using software such as Photoshop or GIMP!

In this exercise, you will learn how to change photos of your block/community to share the ideas you have been
IN THIS EXERCISE PARTICIPANTS WILL LEARN BASIC PHOTO-EDITING TECHNIQUES
talking about with your neighbours. Through the visioning examples, you can explore your block’s potential future
TO CHANGE PHOTOS OF THEIR COMMUNITIES INTO THE KINDS OF PLACES
scenarios with climate change impacts, and possible green and sustainable solutions, and see what your friends and
THEY HAVE BEEN TALKING ABOUT WITH THEIR NEIGHBOURS.
neighbours think!

BEFORE
BEFORE

Solar panels
installed

AFTER

New trees and shrubs
+
food garden

Provides clean energy

Regulates building temperature
Provides animal habitat

Reduces reliance on fossil fuels &
saves $ on produce
by Yancey Chen, Iris Jiang, Shuyan Jing, Jennifer Reid (2017)
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VISION YOUR FUTURE
HOW TO VISUALIZE
Why do this? To imagine what your yard or block will look like by using a visualization tool.
In this exercise, you will try to change photos of your block/community to share the ideas you have been talking about
with your neighbours. Through the visioning examples, you can explore your block’s potential future scenarios with
climate change impacts, and possible green and sustainable solutions, and see what your friends and neighbours
think!
If you have done the vulnerability mapping or the scorecard, please look back to your vulnerability map and/or your
score, think about things that you can do or changes that you want to see in your community to help tackle the risk
features or improve your score, and visualize them!
There are different ways to visualize your ideas:
• With markers (easiest and quickest)
• With photo editing programs such as Adobe Photoshop or GIMP: please see the intruction of GIMP on page
70-72)

Here is the instruction of visualizing with markers:
1. Take a picture or download the Google Streetview of the areas that you want to visualize on
2. Print the photo(s) or picture(s) out in colour
3. Draw your idea on the printed copy (see examples below)
4. Share the product with others!

Printed Google Streetview, after visualization w/ markers

Printed Google Streetview, efore visualization

In this visualization, you can see several features are added to the existing scene, such as:
• Larger trees with bigger canopy
• Speed bumps
• Bike lanes
• Curb extensions for greening
You can add other features in your own visualization as you wish. See more examples next page to get you started!

calp.forestry.ubc.ca/
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VISION YOUR FUTURE
WHAT TO VISUALIZE
Example of features to visualize
Some examples for you to start with:

Sustainable features, such as:

Unsustainable features (possile if we don’t take

action), such as:

• Greenspace (converted from hard pavement)

• Less or none mature trees

• A community garden/orchard
• Solar panels or other renewable energy equipment

• Wider streets to allow for more cars

• Bike lanes, bus stops, or eletric vehicle charging
station

• More street parking on your street

• Potential flooding if close to the sea level

Visualization Examples
EXISITING SCENE

MORE CLIMATE FRIENDLY

Porous
paving
Cleans air pollution

green
walls

Reduces heat island effect

Reduces surface runoff
by Yancey Chen, Iris Jiang, Shuyan Jiang, Jennifer Reid (2017)

EXISITING SCENE

No
actions
taken

LESS CLIMATE FRIENDLY
No shade
Increased air conditioning costs
No habitat for wildlife

Mature
trees
are lost

Increased heat island effect
More surface runoff
by Weicong Fu (2017)

33

calp.forestry.ubc.ca/

VISION YOUR FUTURE
BEFORE AND AFTER

POSSIBLE FUTURE

EXISITING SCENE

calp.forestry.ubc.ca/
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VISION YOUR FUTURE
FROM VISIONING TO REALITY
Why do this? Start thinking of what you want for your yard and neighbourhood. Along with your maps, visualize what
features you want and where you want them. Are your ideas low-cost and low-carbon, or grandiose and high-carbon?

Examples: from vision to reality
Before

After

The lawn in this part of the yard was on a shady
slope beside the house. Problems included:
• Often damp and muddy
• Required frequent mowing
• Not aesthetically pleasing
• Required sprinklers in the summer
• Very few ecological benefits

Installation of a rain garden to replace lawn
space. Benefits include
• Aesthetically pleasing
• Less maintenance
• Creates habitat
• Water conservation
• Filters pollution

35
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VISION YOUR FUTURE
CHANGE YOUR TRANSPORTAION
Visualize your neighborhood street
Why do this? To realize the full potential of a completed road that supports sustainable active transportation and
lower the carbon emission.

You will need:
•

1-1.5 hours

•

Pick a street that you are interested in re-designing

•

Walk around your block or look at Google Earth/ Map Street View to see conditions on the ground

•

Go to www. Street mix (a handy tool that helps you interact with different street elements)

•

Identify the basic characters of your street views and emulate those in the street mix

•

Identify parts of the street (e.g. pedestrain views) that encourage or discourage sustainble transportations ink
those features as well as other relevant factors to climate change

•

Think about what kind of street design (e.g. street width) could help improve conditions in the future

Four driving lanes and two parking lanes

Unhealthy trees living in a limited compacted space

- produce large amount of GHG emissions and energy cosumption
- bicyclist and pedestrain unfriendly
- lack green connections with surrounding green open space

- lack necessary nutrients and water
- increase vulnerabilities during extreme weather events
-discourage people to walk and bike

High percentage of concrete pavement

Inefficient low building

- abosorbs solar heat
- reduces evaporation
- reduces water infiltration

calp.forestry.ubc.ca/

- spread carbon footprint
- lack connectivity, compaction and communication
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STEP 5: ACT ON THE GROUND

Now that we know the urgency of combating climate change, and the importance of urban trees in climateproofing our communities, how could you take action together?
This section provides you tips and external resources on what you can do to help.
1. PRIORITIZE AND MAKE A PLEDGE so you can list your goals and tasks
2. MAKE A PLAN and quickly see what goals you plan to accomplish and when
3. BEAUTIFY & CLIMATE-PROOF YOUR HOME with an array of different activities, each involving
a way to act on the ground
4. BEAUTIFY YOUR BLOCK with you neighbours after you’ve made a difference in your own home!
5. RETROFIT YOUR HOME AND YOUR COMMUNITY to further reduce your GHG emissions

by laura.ouimette
calp.forestry.ubc.ca/
https://www.flickr.com/photos/8244126@N06/512532859
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ACT ON THE GROUND
PRIORITIZE & MAKE A PLEDGE
Why do this? To prioritize the ideas you have from your visioning and scorecard.
What goals are you planning to achieve in the new year? Are they about

You can start with
SMALL steps

preparing your house for climate change, or protecting trees in your yard
or block? Find out what your neighbours have been pledging, and work
towards the goals together!

Write them down!

I PLEDGE
#1
e.g. plant a suitable tree that I like in my yard and take good care of it

#2
e.g. water street trees on my block during dry seasons

#3
e.g. volunteer at least once at a City tree planting event with my family and/or neighbours

DO YOU KNOW?
Vancouver has a Climate Change Action Pledge:
ht tp://vancouver.ca/green-vancouver/
climate-change-action-pledge.aspx
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ACT ON THE GROUND
MAKE A PLAN
What will you do by when?
Make a calendar to plan small steps that can help you achieve your climate action goal(s), and put your plan in a
place where you can see it everyday! When setting a goal, try addding a deadline to make actions bite-sized and
more achievable. Use a wall calendar hung in an obvious location, or go digital with an Excel calendar template.
Here is one resident's action plan for part of the month.

MYGREEN PLAN
WEEK 1:
Buy and plant some sweet peas in back yard tomorrow
Get bike fixed by this weekend
buy pea seeds after work

prepare soil
for peas and
plant

fix bike

WEEK 2:
Buy and plant an Eastern redbud by this weekend
Ride bike to work this week
Volunteer at a City tree planting this or next week
Water
peas

Buy digging
shovel, mulch...

Buy and plant the tree
**WATER & MULCH

bike to work!

City Tree
planting @ 10

WEEK 3:
Replace some of front lawn with native plants this week
Ride bike to work two times this week
Discuss gardening workshop idea with neighbours Thursday latest
3

bike!
Water
peas and read up on
tree
native plants

calp.forestry.ubc.ca/

dig up front
lawn
order topsoil

Workshop plan
w Evelyn @ 6

bike!

buy native plants
ask kids to water yard
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ACT ON THE GROUND
MAKE A PLAN - CALENDAR
WEEK 1:

eg. Read the Coolkit pages 7-8 on urban forests tonight.

THIS MONTH
01 02 03 04 05 06 07 08 09 10 11 12

WEEK 2:

WEEK 3:

WEEK 4:
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ACT ON THE GROUND
BEAUTIFY & CLIMATE-PROOF YOUR YARD
A. Pick up an appropriate tree
Why do this? To plant trees that are easy to maintain and able to survive the future impacts of climate change13 14:

‘Forest pansy’ eastern redbud15
(Cercis canadensis)
by Mohamed Rezk

by Famartin

Medium-size (6 to 9 m tall) deciduous tree with beautiful
pink flowers and heart-shape leaves
•

Can survive well in a very dry environment

•

Prefer full or partial shade

•

Grows in well-drained sandy/clay soil

by Ted

leaves

‘Elegant warrior’ Japanese snowbell

16

(Styrax japonicus)
Medium-size (9 m) deciduous tree with upward foliage and
drooping flower clusters
•

Can survive in harsh conditions with little care

•

Pefers full sun to part shade

•

Prefers organically rich, acidic, medium moisture, welldrained soils
flowers

by meadowsfarms

‘Workhorse’ european hornbeam16
(Carpinus betulus)
Large (can be over 12 m) deciduous tree with pointy oval
leaves, and a beautiful canopy

by claude05alleva
by WikimediaImages

•

Can survive in harsh conditions with little care

•

Tolerant to various levels of light exposure and soil pHs

•

Prefers moist and well-drained soil

by Wendy Cutler

calp.forestry.ubc.ca/
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Leaves in the Fall

‘Tough Survivor’ Honey Locust'17
(Gleditsia triacanthos)
Medium- to large-sized deciduous tree that can grow
over 20 m with beautiful bright yellow flowers in the fall.
It is fast-growing and easy to plant.
•

Flood and drought tolerant

•

Prefers to grow with full sun exposure

•

Grows in various types of soil
Flower and Leaves

by Kevmin

by iangbl

Flowers

‘Pollution fighter’ garry oak'18 19
(Quercus garryana)
The only native oak species in BC. It can grow over 20 m
tall a with majestic large canopy. It is great for improving
air and water quality, and provides habitat for a number
of rare plants and animals.

Leaves

•

Once established, minimal maintenance is needed

•

Can tolerate very dry conditions

•

Prefers open space with full or partial sunlight

•

Grows in well-drained coarse sandy soil

WANT TO KNOW MORE SPECIES?

WHERE CAN I GET A TREE?

Trees in B.C. and identification keys:
https://www.for.gov.bc.ca/hfd/library/documents/treebook/trees.
htm

You can buy trees for only $10 at Vancouver's Tree Sale
Events, which happen three or four times a year. Check
the City's website for more information: http://vancouver.
ca/parks-recreation-culture/vancouver-tree-weekend.
aspx

Tree Keepers:
http://treekeepers.ca/plant-a-tree/
Native plants in BC:
http://www.npsbc.ca/
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B. HOW TO PLANT A TREE
Need some help planting a tree? Here are some guidelines from the Vancouver Board of Parks and
Recreation22:
1. DIG A SAUCER-SHAPEd HOLE 3-4 times wider than the container or rootball. Make sure it is the same depth
as the root ball.
2. PLACE THE TREE IN THE CENTRE of the hole. The top
of the rootball must rest at ground level. If your tree is in a
container, gently tap the sides of container to help loosen
the edge and slide the tree out carefully.
* DON'T PLANT TOO DEEP! Roots require air as well as
water to grow. The tree's root flare (the bottom part of the
trunk that flares out) should be above the soil.
* To prevent the roots from growing in a circular pattern
(known as girdling roots), cut a few vertical slices along the
sides of the rootball. You can also gently spread the roots
making sure not to break them.

Ensure you remove the tree from its container before planting

* FOR BALLED & BURLAPPED TREES, cut away any twine
or wires wrapped around the rootball and peel back the
burlap.

3. BACKFILL THE HOLE WITH NATIVE SOIL FROM THE
TREE PIT. If the soil is of marginal quality, ensure that
topsoil amendment is thoroughly mixed with native soil.

Girdling roots can cause harm to your tree

SOME MORE TIPS ON TREE CARE22:
1. MULCH is an invaluable tool to improve the soil and provide more nutrients
for the trees.
2. BEWARE OF THE WEED EATER. They can do devastating damage to trees.
3. REMOVE THE GRASS growing right around the base of your tree. Grass
competes with the tree for water and nutrients, causing more stress for the tree.
4. If you want to prune your tree, it's best to CALL THE CITY! They have tree
experts to advise on making your tree feel good and look good. Contact them
at 3-1-1.
FOR MORE TIPS, please see the full version: http://vancouver.ca/files/cov/vancouver-tree-week-caring-for-your-tree.pdf

calp.forestry.ubc.ca/
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C. PICK UP A NATIVE SHRUB YOU LIKE
Why do this? To introduce the benefits of native species.

Native plants

are those that are found naturally in a particular area, and are well adapted to its
climate . Native plants help mitigate climate change because they require less resources (less watering for you!), are
low maintenance, and provide habitat for birds and other wildlife41. Beautify your yard with some!
40

Nootka rose42

(Rosa nutkana)

Growing up to 2.5 m tall, this rose makes a great shurb for hedges or
barriers. It bears velvety pink flowers in summer, each 5 to 8 cm accross.
Leaves are light green and toothed at the edges.
• Enjoys wet conditions
• Tolerates full sun to partial shade exposure

Red elderberry42

(Sambucus racemosa)

This plant bears pyramidal clusters of small white flowers in early
spring, and the bright red berries attract birds. It forms a large shrub
once mature and grows quickly once established.
• Enjoys moist but drained conditions
• Shade tolerant

Salmonberry42

(Rubus spectabilis)

This fast-growing shrub bears yellow or orange-red raspberry-like fruit.
The fruit can be used in wines and jam. The end leaf is larger than the
two side leaflets.
• Enjoys moist or well-drained sois
• Requires full shade

Red-osier dogwood42

(Cornus stolonifera)

Clusters of small white flowers span 3 to 6 cm in diameter, and bear
small white berries. Interesting fact: wherever the bright red branches
touch the ground, new plants grow.
• Enjoys well-drained soils
• Full sun exposure

False lily of the valley42

(Maianthemum dilatatum)

A deciduous plant that acts as a superb groundcover, forming an ocean
of dark green leaves. The heart-shaped leaves are glossy, and tiny white
star-shaped flowers are borne on stalks in late spring. Immature berries
are speckled and flush red after late spring. Fast grower.
• Moist soil
• Prefers shade
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D. IDENTIFY INVASIVE SPECIES
Why do this? To familiarize with some invasive species in order to remove them.
Invasive plants are those that have been introduced from other parts of the world and create substantial negative
impacts on native plants43. Here are some plants you may have seen before:

Can you find me?

ex. English Ivy

Play a game of I-spy and find out how dominant the invasives are in:
(a) your block (b) your front/back yard
Next to each invasive plant, rate their dominance with 0 as low and 5 as high

(a) __1__
(b) _ 3__

(a)

(a)

(b)

(b)

Morning glory42 (bindweed)

English holly42

(Calystegia sepium)

(Ilex aquifolium)

A long trailing vine bearing large bell-shaped
white flowers that bloom in June. Ensure
that roots are dug out and no remains are
left - any leftover plant material can regrow.

Dark green leaves contrast with the bright
red berries for this holly. This shrub can grow
up to 10 m tall, depriving other plants of
sunlight

(a)

(a)

(b)

(b)

English ivy42

Himalayan blackberry42

Once a common wallcover, English ivy
is now seen as an annoying invasive. It
grows horizontally but will climb given the
opportunity. All Hedera plants are potentially
invasive.

While it provides berries for wildlife, its fastgrowing nature prevents the establishment
of native groundcovers. This blackberry has
5 oval or oblong leaflets and prickles on the
stems.

(Hedera helix)

(Rubus armeniacus)

To learn more about invasives, please visit: http://www.surrey.ca/files/Invasive_Plants_Brochure.pdf
calp.forestry.ubc.ca/
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E. WHERE TO PLANT
Why do this? To aquaint yourself with your yard, and enhance the benefits that the trees provide.
Here are some tips and examples of how you can organize and design your yard, along with some helpful tips on
where to plant your tree for energy use and comfort.
Ex. 1

Ex. 2a
Simple

Ex. 2b
Complex

Souce: Forest Stewardship Backyard Trees

To learn how to design
your garden in detail, as
seen in this photo, visit:
https://ncsu.edu/
goingnative/howto/
mapping/index.html
Souce: North Carolina State University

KEY
1.
2.
3.
4.

Coniferous windbreaks to the north and west block winter winds.
Trees on the east and west sides provide cooling effects with summer shade.
A tree here will provide cool shade as the sun sets in midsummer.
A variety of deciduous trees to the south should grow tall to shade the building and
pruning of the lower branches will allow the lower winter sun to strike the roof, walls, and
windows uninterrupted.

*Adapted from Forest Stewardship Backyard Trees (see above image)21
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ACTIVITY: GET TO KNOW YOUR YARD
In the space below, roughly draw your front or backyard and its main features (large trees, benches, walls, slopes,
etc...). Keep the drawing simple as you will be adding notes and plants!

Use different coloured pens or highlighters to mark each section.
Along with the Key on page 47, indicate:
1. Areas with most sunshine - good for vegetable growing or drought-tolerabt plants
2. Areas with least sunshine - a possible shade garden for cooling
3. Wet and dry areas (areas prone to flooding or drying out easily) - rain gardens for wet areas
*With the above information, you can plan where to place your native plants (page 45)
4. Existing large trees (the larger the tree, the more shade there will be around it
5. Other locations you have/want in your yard (e.g. a private retreat, child's play area, deck for hosting outdoor
events...)

calp.forestry.ubc.ca/
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HOW TO CARE FOR YOUR YARD & GARDEN
Why do this? To create an eco-friendly yard and save time and money!

RESPONSIBLE LAWNS

BE WATER WISE

Micro clover lawn

A rain water collection barrel By Benoit Rochon
•

Spring loaded shut-off nozzles are required on hoses all year

•

•

Select drought resistant plants in areas which are dry in the
summer28, 29

Reduce how often you mow - mowers require fossil fuels and
can release more carbon emissions than grass absorbs34

•

Consider replacing some lawn area with garden beds for
trees and flowers - they add beauty and important ecological
benefits

37

•

Install a rain barrel to collect water - use in your garden during
water restrictions28

•

Apply mulch around plants which are not drought resistant to
reduce evaporation28, 29

•

Seed your lawn with micro clover - it will stay green longer,
and support other plants by enriching the soil39

•

Consider installing a rain garden in part of your garden - it will
filter pollution and reduce surface run-off38

•

European chaffer beetles can be effectively treated with
beneficial nematodes27

Learn how to be waterwise:

See more on lawn alternatives at:

Waterwise gardening:

Grow Green Guide - Lush Lawns:
http://www.growgreenguide.ca/lawns

www.metrovancouver.org/services/
waterWaterPublications/

REDUCE DISEASE & PESTS

SUPPORT YOUR SOIL

Lady bugs - effective aphid control

A backyard composter
•

Get a composter for your yard - leaves and trimmings will
become a natural fertilizer for your garden30, 31

•

•

Ensure your soil is well drained - compact soils can hold too
much moisture and may restrict root growth31

•

Select plant varieties resistent to pests and disease33

•

There are natural, biological ways to control pests that are
safe and effective, for instance lady bugs and beneficial
nematodes27

•

Organic fertilizers are released slowly and help improve
soil structure over time32

The City of Vancouver does not allow the use of pesticides
for cosmetic reasonsin home gardens or lawns33

Want to know more?

Want to know more about composting?

Pesticide-free lawns and gardens:

Backyard Composting:
http://www.metrovancouver.org/services/solidwaste/SolidWastePublications/HeresTheDirt.pdf

http://vancouver.ca/home-propertydevelopment/gardening-naturally.aspx
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ACT ON THE GROUND
GREEN & CLIMATE-PROOF YOUR BLOCK
A. CREATE A STREET GARDEN
Why do this? You can easily create a street garden in traffic circles or even on the street in front of your place by
planting vegetation that you like! Creating this type of green space can benefit you and your block in various ways23:

1. Boost the character of your block by personalizing gardens
2. Slow down traffic on your block
3. Provide free compost for your own garden, and sometimes
even free food (depending on the species that you plant)
4. Strengthen the bonds with your neighbours and friends
5. Provide habitat for important pollinators
6. Add to summer shade with deciduous tree(s)

by Erin MacDonald

STEPS TO CREATE A STREET GARDEN23:
1. Decide what type of garden you and your neighbours want
to create: e.g. food gardens, bee hives, ornamental gardens...
2. Pick plants that you like.
Recommended plant list: http://vancouver.ca/home-propertydevelopment/recommended-plant-list.aspx

3. Plan a day with your neighbours to plant!
Watch out for traffic when you are working. Stay visible and stay
alert.
For more specific rules and guides, please visit http://vancouver.
ca/home-property-development/gardening-guidelines.aspx

calp.forestry.ubc.ca/
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You can also volunteer for the City's Green
Streets Program to help them take care of
street gardens near you. You will weed and
water the gardens, make new friends, receive
free training on gardening, and go to various
fun events by the Green Streets23.
Sign up here: http://vancouver.ca/homeproperty-development/green-streetsvolunteer-application-form.aspx

B. TAKE CARE OF PUBLIC TREES

HOW CAN I HELP MY TREE?

by City of Vancouver

by Gratisography

http://vancouver.ca/files/cov/vancouver-tree-week-caring-for-your-tree.pdf

https://static.pexels.com/photos/2259/man-hand-garden-growth.jpg

BE CAREFUL WHEN USING A
LAWNMOWER OR WEED TRIMMER12

WATER STREET TREES OVER THEIR ROOTS
IN FRONT OF YOUR YARD 12

It can do detrimental damages to the base of the tree.
Severe damage (like the picture) can kill a mature tree.

Two watering cans or 5-10 minutes from a slow-running hose
during summer. Twice per week per tree will do.

by StuJP
http://www.geograph.org.uk/photo/4589591

TELL THE CITY IF YOU HAVE ANY
QUESTIONS OR CONCERNS12

PARTICIPATE IN ARBOR WEEK
TREE-PLANTING ACTIVITIES12

You can request maintenance of trees in parks and on streets online
http://vancouver.ca/home-property-development/trees.aspx

The City and various organizations e.g. TreeKeepers
organize at least one tree-planting event per year.
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ACT ON THE GROUND
DEVELOP A LOW-CARBON LIFESTYLE
TRANSPORTATION AND ENERGY CONSUMPTION are the two biggest contributors to BC household’s
carbon footprint. Here are 2 ways to help you reduce your carbon footprint and become more sustainable:

1. TRAVEL MORE SUSTAINABILY
Our transportation (cars, trucks, planes etc.) contributes to more than half of the average BC household’s carbon
footprint. It also accounts for noxious air pollution, common air contamination, and water toxicity44

Walk or bike more
in 10 minutes, you can walk 1 km or bike 3.5 km. In the same time, you can:
•

Keep fit
A125-lb (57kg) person walking at brisk pace for 30 minutes burns about 150 calories45

•

Save money (gym fees or car expenses)

•

Save time

Calculate the calories you can
burn by walking here:

For short distances (< 10 km), cycling is usually the fastest way to travel in the city

http://www.shapesense.com/fitnessexercise/calculators/walking-calorieburn-calculator.shtml

Take public transit
Read the news, chat with friends, or take a nap! Taking transit is much cheaper than owning a car: the average
savings are $586 per month for a family using public transit instead of driving.

Carshare or carpool
It's a great way to bypass traffic congestions (by driving in HOV lanes), save expenses and meet new people!

calp.forestry.ubc.ca/

52

ACT ON THE GROUND
DEVELOP A LOW-CARBON LIFESTYLE
2. REDUCE ENERGY CONSUMPTION AND INCREASE RENEWABLES
Canada is No. 1 when it comes to energy consumption per capita. We are consuming as much as the continent of
Africa, which has double the population of Canada44! In BC, energy use accounts for a quarter of the household’s
carbon footprint on average.

Install solar pannels and solar PVs
Rooftop solar – uses photovoltaic cells to harvest the sun’s energy and convert that into electricity.
Solar hot water system – solar thermal collectors circulate a fluid which is heated by the sun’s radiant energy.
To read more: https://www.forbes.com/sites/houzz/2014/05/17/everything-you-need-to-know-about-adding-solarpanels-at-home/#46ad17b8740e

Use more Energy Star appliances46
An Energy Star certified CFL or LED bulb saves up to 30% energy and lasts 10-25 times longer. An Energy Star
certified laundry machine can save 35% on energy and water.

Turn off electronics when you are not in the room
It costs $20 per year to keep one light on 8 hours everyday for a year.

Turn your thermostat down by 2 degrees
That is equivalent to a 5% reduction in heating energy

Seal the heat leaks and insulate your home
Check walls, doors, and windows for draft. If you don’t know how, this video can help: http://www.youtube.com/
watch?v=mGPg-uxl5qk.
You can also get a thermal image of your house to identify heat leaks and opportunities for energy efficiency upgrades. What is a thermal image? A thermal image is “a picture of the heat that comes off objects47”. To request a
thermal image of your home, please contact the City at thermal.imaging@vancouver.ca.
Insulate the roof, floors, walls, and the basement to keep your house cool in the summer and warm in the winter.

Think about district energy systems:
Networks of hot and cold water pipes, typically buried underground, that are used to efficiently heat and cool building using less energy than if the individual buildings were to each have their own boilers and chillers
To read more: http://energy.ubc.ca/projects/district-energy/

Use heat pumps and geo-exchange:
Heat pumps can take heat from the air or ground and use it to provide space heat or hot water.
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ACT ON THE GROUND
DEVELOP A LOW-CARBON LIFESTYLE

ACT ON THE GROUND
RETROFIT YOUR HOME
City of Vancouver’s
Renewable City Strategy on
zero emission building priorities

1. New buildings to be zero-emissions by
2030
2. Retrofit existing buildings to perform
like new constructions

A. Make your home energy efficient
Retrofits are enhancements and changes to existing buildings to make them more comfortable and energy efficient. Because most buildings today will be around in 50 years, increasing their efficiency is a crucial step to low-carbon resilience, lower energy bills, and meeting community GHG reduction targets50.

Energy smart green building
Green buildings refers to both a structure and the application of processes that are environmentally responsible and resource-efficient throughout a building’s life-cycle: from planning to design, construction, operation,
maintenance, renovation, and demolition. The Green Building practice expands and complements the classical
building design concerns of economy, utility, durability, and comfort51.

Do you know that?
Basic building retrofits, such as adding solar hot water can reduce total
energy use by up to 30% and greenhouse gases by 33%. Major building
retrofits, such as air source heat pumps
and other renewable energy appliances can reduce total energy use by
75% and GHG emissions by 80%52.

by Community Energy Explorer@

Do you have a better idea about home energy efficiency?
Bear the principles in mind and let’s start our game!
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ACT ON THE GROUND
RETROFIT YOUR HOME
Why do this? To gain more knowledge about how to retrofit your home into an energy smart green house.

You will need:
•
•
•

0.5- 1hours
Think about new design possibilities and fill the blank spaces with your brilliant ideas about retrofitting this
building ( hints are given by lines connecting to the installations)
Check the answers on page 58 to see if you can recognize all of the smart ideas

by ideal homes@1

Interested in home retrofit?
Here are some relevant links to help you to change behaviors and redesign your house!
Ways to save heat and fuel at home: http://www.nef.org.uk/knowledge-hub/energy-in-the-home/ways-tosave-heat-fuel-at-home
Top 11 things you didn't know about saving energy at home: https://energy.gov/articles/top-11-things-youdidnt-know-about-saving-energy-home-summer-edition
Brilliant ideas about how to reduce your building carbon footprint and reduce energy consumptions: http://
www.metalarchitecture.com/articles/8-tips-to-reduce-your-building-carbon-footprint

calp.forestry.ubc.ca/
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ACT ON THE GROUND
RETROFIT YOUR COMMUNITY
City of Vancouver’s
Renewable City Strategy on
zero emission building priorities

1. Expand existing and develop new neighbourhood renewable energy systems
2. Ensure grid supplied electricity is 100%
renewable

B. Redesign your community
Why do this? To identify solutions and create a more efficient, sustainable and cost-effective neighborhood through
collective action at the community level

What is community energy?
Community energy refers to multiple energy sources and distribution networks that are shared between various
members of a geographic neighborhood, with at least part of the energy generated in the local area 54.

You will need:
•
•

0.5-1hours
Think about new design possibilities and fill in the blanks with your brilliant ideas about energy use in your
neighborhood enhancement (hints are given by arrows pointing to the sketch)

•

Check the answer on page 59 to see if you can recognize all the smart idea

Supporting Indicators:
housing type/ residential density/ commute by mode/ green space/ floor area/ walkscore (where available)

Interested in the animation of climate change and community design?dExplore the following wesite:
http://www.climateandcommunity.ca/#first
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VISION YOUR FUTURE
RETROFIT YOUR HOME-ANSWERS
Did you get it?

Answers
1. high-efficiency gas heating/ air conditioning
2. Roof sheathing

Reduce radiant heat transfer through the roof by 97%. Read more: https://energy.gov/energysaver/radiantbarriers

3. Advanced framing techniques
Reduce air linkage and ensure a tight envelope

4. Pressure balancing
5.Energy star appliances
To read more: https://www.energystar.gov/products/appliances

6. Mastic sealed a/c ducts
Wrap the ducts in mylar and reduce the duct leakage

7. Polycell caulking
Cut down leaks and air infiltration - makes a more energy efficient home
Read more: https://www.todayshomeowner.com/video/how-to-caulk-and-seal-gaps-and-cracks/

8. Vinyl window with low-E glass

Keep warm air in during the winter and hot solar rays out during summer.
Read more: https://energy.gov/energysaver/energy-efficient-windows

9. Blown-in insulation
Eliminate gaps by completely filling wall cavities with insulation and reduce air filtration.

10. Tyvek
Provide a breathable moisture barrier around the house

11. Perimeter insulation
Reduce the heat loss through the slab
Read more: https://buildingscience.com/documents/information-sheets/slab-edge-insulation
calp.forestry.ubc.ca/
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ACT ON THE GROUND
RETROFIT YOUR COMMUNITY-ANSWERS
Did you get it?

Answers
1. Completed and connected community

About 2500 residents are within a 5 minute walk of shops, services and offices in two neighborhood centres

2. Building retrofit
See detailed installations in the house/apartment modules

3. Enfficient housing type
Households in duplex, townhouse, and apartment dwellings located near services can reduce
household energy costs by about 60% compared to suburb households

4. Tree shading
Trees on the east and west side provide cooling effects with summer shade – saving energy for air
conditioning; pruning lower branches of deciduous trees to the south will allow the lower winter sun
to strike the walls – saving energy for heating

5.Pumps and geo-exchange
Heat pumps can take heat from the air or ground and use it to provide space heat or hot water

6. Solar energy/ solar water hot system
Rooftop solar – uses photovoltaic cells to harvest the sun energy and convert that into electricity.

7. District energy system
Networks of hot and cold water pipes, typically buried underground, that are used to efficiently heat
and cool buildings using less energy than if the individual buildings were to each have their own
boilers and chillers. See an example in downtown Vancouver: http://vancouver.ca/home-propertydevelopment/southeast-false-creek-neighbourhood-energy-utility.aspx
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VISION YOUR FUTURE
RETROFIT YOUR HOME-ANSWERS
Think about those new designs a bit more...
Are you familiar with all those installations?
Which ones do you know a lot about and which ones you have never heard of?

Have you or your family installed these retroftis at home?

Which ones do you want to install at your home in the future?
List the 3 most likely and 3 least likely, and discuss this with your friends.
(Think about factors such as cost/ livibility/ community support)

Do you think your family and your neighbours can work together to decrease the carbon footprints for
your family and your community to 33% by 2020 (Remember: the City of Vancouver and BC also have the
same target)?

Are there any other sustainable home energy efficiency designs that you can think of?

calp.forestry.ubc.ca/
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ACT ON THE GROUND
RETROFIT YOUR COMMUNITY-ANSWERS
Renewable City Strategy on
Strategic active transportation

1. Reduce energy use.
2. Increase the use of renewable energy.
3. Increase the supply of renewable energy.

Active and sustainable transportations benefit you and your block in various ways
•
•
•
•
•

Lower GHG emissions
Reduce pollutions emitted by motorized vehicles
BIOPHILIA: build connections with nature
Increase urban forest/tree canopy and promote walking
Mimic natural hydrology and facilitate water infiltration
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ACT ON THE GROUND
ADDITIONAL RESOURCES
Here are some additional resources that you may find interesting. Reading materials refer to resources that contain articles or
documents, while online or interactive tools involve clicking around exploration of different information resources..

READING MATERIALS

•

Vancouver’s Renewable Energy Strategy:
http://vancouver.ca/files/cov/renewable-city-strategy-booklet-2015.pdf

Incorporating environmental, social, and economic pillars of sustainability, the Renewable Energy Strategy lays out goals and
tasks Vancouver must take to achieve 100% renewable energy in 2050 and reduce GHG emissions by 80% before 2050.

•

Vancouver’s Greenway Network: http://vancouver.ca/streets-transportation/city-greenways.aspx

•

Urban Forest Climate Adaptation Framework for Metro Vancouver:
http://www.metrovancouver.org/services/regional-planning/PlanningPublications/UrbanForestClimateAdaptationFrameworkTreeSpeciesSelection.pdf

Learn more about Vancouver’s many greenways, and where the nearest one to you is located. Once complete, the greenway network will
reach 140 km long and span from Marpole to False Creek!

What are the risks facing urban forests? How can we build resilience going forward? This strategy outlines the current condition of our urban forests, labels the threats, and describes how to move towards a more resilient future.

•

Climate Action in BC: http://engage.gov.bc.ca/climateleadership/climateaction/

What has BC done to fight against climate change? Visit this site to see what has been done in the built environment, transportation, and
industry sectors as well as across sectors.

ONLINE or INTERACTIVE

•

Community Energy Explorer: http://energyexplorer.ca/

•

World Bank GHG Emissions Map:
http://data.worldbank.org/indicator/EN.ATM.GHGT.KT.CE?end=2012&start=2012&view=map

An interactive website that allows you to explore community energy. Zoom in on your neighbourhood and see what the energy potentials
are for each community .

Curious about the emissions of other countries? Discover the emission levels of all countries and economies..

•

Leafsnap (app): leafsnap.com
Snap a photo of a leaf, seed, or flower from an unknown tree and this app will help you identify it.

•

Grow Your Garden or Find the Right Plant: http://www.growgreenguide.ca/
This website gives you a variety of beautiful garden-bed layouts, and helps you find the perfect plant for any corner in your garden.

•

Treepedia: http://senseable.mit.edu/treepedia/greenindex/london/d7laGxAA2RAQgVPDrL1uwQ
Just how much canopy cover does Vancouver have relative to other cities? This website shows you the approximate green canopy cover of
over twenty major cities, including Berlin, Seattle, Tel Aviv, and Cape Town.

calp.forestry.ubc.ca/
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CONGRATULATIONS!
(Full name)

HAS COMPLETED ALL COOLKIT STEPS!
Starting date:
Finishing date:

Wow - you have finished the Coolkit!
How do you feel? What did you learn after this journey?
Let us know your thoughts at our website http://calp.
forestry.ubc.ca/home/urban-forestry-toolkit/
OR
email us at citizenscoolkit.vancouver@gmail.com
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APPENDIX

You’ve made it this far! This is the section for those interested in going the extra mile in
their activities or are more computer-oriented. Here are further instructions for activities
requiring the use of computer software.
1.

HOW TO MAP with Google Earth

2.

HOW TO MAP with i-Tree

3.

HOW TO MAP with Vanmaps

4.

HOW TO VISUALIZE with GIMP

calp.forestry.ubc.ca/
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MAP YOUR BLOCK
HOW TO MAP WITH GOOGLE EARTH
You will need:
•
•

1-2 hours
A computer connected to the Internet

CREATING POLYGONS (HABITAT)
Here we use canopy mapping of squirrel habitat as an example:
1. Download Google Earth Pro (free) on your computer first. You can download it here: http://www.google.com/
earth/download/gep/agree.html.
2. Type your address in the search bar on the left panel of Google Earth to find your place.
3. Menu bar:

4. Use the
button to add and create a polygon. Click points around the border of the canopy that you would
like to mark. Left-click adds a new vertex (point), right-click removes the last vertex that you added. Click
to finish tracking.
5. Continue adding polygons for each area of canopy. You will see them show up in your Places menu on the left
panel. Map all trees or tree clumps on your property, and give each tree/canopy a unique name as you like.

Want to learn more? Please
go here:
https://www.google.com/ea
rth/learn/
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MAP YOUR BLOCK
HOW TO MAP WITH I-TREE
You will need:
•
•

1-1.5 hours
A computer connected to the Internet

What is i-Tree?
i-Tree (http://www.itreetools.org/) is software developed by the US Forest Service to provide urban/rural forestry
analysis and assessment. Here we will use one of the i-Tree tools, i-Tree Canopy, for this exercise. You will find out
the % coverage of each habitat and estimated ecosystem services of greenspaces on your block by using this tool.

MEASURING LANDUSE TYPE
COVER
Here we use canopy mapping (squirrel habitat) again as an example:
1. Go to https://www.itreetools.org/canopy/index.php.
You should see the webpage on the right.
2. Click
and click

when the pop-up appears,

3. When the map appears, enter any address into the
search bar on the top right (or zoom onto Vancouver)
and make a polygon of your block. Click Finish when
you are done.

step11
Step

4. The website will bring you back to the main i-Tree Canopy page. Click
5. A new page will open with your i-Tree classes. The default classes are Tree and Non-Tree.
Change the classes as squirrel habitat, car habitat, worm habitat, and pigeon habitat by selecting
one of the four icons directly under your classes.
Feel free to use these classes or make your own (some
suggestions are: water, buildings, grass, and soil).
Note that some classes may be difficult to distinguish
from each other by just using the images, so make sure
that you can tell the classes apart.
calp.forestry.ubc.ca/
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Step
5
step5

6. A new page will open asking you questions about
how to quantify the benefits of your urban forest.
Change the currency to Canadian dollars (CAD).
Keep the project location as the USA., as that is currently
the only available location.

7. Now we get to place random points and classify
them!
Under

click the

symbol.

Which one of your classes does this point correspond
to? Change the Cover Class to the class you want and
click the
symbol again. Do this at least 100 times
to get a good representation of points for each class
(at least 30 for each class). Do it more than 100 times
if you’re having fun!

step6
Step
6

Save your data to make sure that you don’t lose it

to see the ecosystem services provid8. Click
ed by the trees and greenspace in your area, such as
pollutant removal, carbon sequestration.
Stepstep
77

Step 8

The tree benefits estimate table provides insight into the ecosystem services provided by trees on your block - trees remove many com- pounds from the air, such as pollutants and greenhouse gases, which would otherwise be very costly to manage

NOW YOU CAN TELL PEOPLE QUANTITATIVELY HOW IMPORTANT TREES ARE TO THE CITY!
esaeto
lPlearn
?eromore?
m nraPlease
el ot tvisit:
naW
Want
:ereh og
https://www.itreetools.org/reae/moc.elgoog.www//:sptth
sources/
/nrael/htr
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CALCULATING THE AREA OF A POLYGON - GOOGLE EARTH
Google Earth Pro is free to download

1. Once you have created a polygon in Google Earth, right-click it in the Places menu (on the left of the
screen). Select “Get Info” and a Google Earth – Edit Polygon window opens up. You can see the measurements of the polygon’s area and perimeter by looking under the button
You can also change polygon styles (e.g. colour, transparency) in the Properties window under Style, Color tab
(see picture in the previous page).
2. Measure the area covered by trees in your property, and divide this by the total area of your property:

You will get a percentage of area covered by tree canopies, which is the tree canopy cover.
You can also measure the tree canopy cover of your block and compare with the city’s average (18%).
DON'T FORGET TO SAVE YOUR WORK: click File> Save> Save my places, and all of the polygons will be saved
to the My Places section of the Places menu.

CALCULATING THE AREA OF A POLYGON - EARTH POINT
*To use Earth Point, you need Google Earth installed on your computer.

1. Open a new tab on your browser and visit
http://www.earthpoint.us/Shapes.aspx.
2. Go back to your polygon in Google Earth, right-click and click “Copy”.
3. In your Earth Point website, paste into the text box.
4. Choose your preferred dimensions
5. Calculate and view the results

Step 3

Step 5
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MAP YOUR BLOCK
HOW TO MAP WITH VANMAP
You will need:
•
•

1/2 - 1 hour
A computer connected to the Internet

What is VanMap?
VanMap is an interactive mapping tool available on the City of Vancouver’s website. It allows you to view many different
features such as property lines, zoning districts, streets, traffic counts, water utilities, and many more. You can also view
high quality aerial photos of the Vancouver area which provides photo detail not accessible on Google Earth - this can
be very useful in cases where you want to look at various features in you neighbourhood more closely.

FINDING AERIAL PHOTOS & CREATING POLYGONS
1.

Go to http://Vancouver.ca/your-government/vanmap.aspx and click
on

2.

Enter your cross street or address at the top left search field to find
your block on the map and zoom in by clicking

3.

Uncheck all the legend boxes except ‘Aerial Imagery’ and select an
orthophoto of your choice

4.

You can move around the map using the pan tool

5.

You can create polygons by selecting
in the tool box. These can
be used to map areas of risk or habitats. Skip this step if you would
like to draw on your map by hand

6.

Print out the image by clicking

7.

If you are having fun, try exploring the different features and tools
available to learn more about your block and neighbourhood!

Step 2

in the toolbox

Step 3

Detailed aerial photo with street names overlayed

Step 5
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VISION YOUR FUTURE
HOW TO VISUALIZE
There are many ways to visualize your block in the future. Here are two common ways:
1. With markers (easiest and quickest) – Page 22
2. With GIMP (free alternative to Photoshop) – Page 70

1. VISUALIZE with markers
Print a few copies of the street views on your block, and use markers to draw out the following scenarios. Please see
detailed instructions on page 22.

You will need:
•
•
•

30 minutes
Several colourful markers
Several photos of your block/yard to map on
You can print them on regular paper instead of photo paper. Recommended size: 11" by 17" or 18" by 24".

2. VISUALIZE with
There are several kinds of visualization tools that are easy to access and use, e.g. GIMP, Photoshop, Sketchup...
Here are some useful tutorials if you want to try them out:
• Adobe Photoshop: https://helpx.adobe.com/photoshop/tutorials.html
• Google Sketchup: http://www.sketchup.com/learn

by Mengqiu Chen, Kristin Defer, Alfred Duval, Siyuan Zhao (2015)

A student visualization of a “greened” block, with icons on the right to indicate improvements
calp.forestry.ubc.ca/
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VISION YOUR FUTURE
VISUALIZE WITH GIMP
You will need:
•

1-1.5 hours

•

A computer connected to the Internet

•

Pictures in which you want to visualize potential futures

What is GIMP?
GIMP (https://www.gimp.org/) is free image editing software that allows you to compose and retouch digital images.
Here are some quick tutorials to help you visualize with GIMP (the following content is adapted from the GIMP User
Manual11:

GIMP QUICKIES: FIRST AND FOREMOST...
Go to https://www.gimp.org/downloads/ to download the installation package and install GIMP by following the
instructions.
Here is a quick intro of some key concepts and the interface of GIMP:
•

IMAGE - basic entity to display and retouch in GIMP. It is like a single sheet of paper where you can draw.

•

LAYER - similar to digital tracing paper stacked on top of the other, so you can draw on each paper (i.e. image) but still
see and preserve the original the content of the other sheets.

•

UNDOING - this is very important to know especially when you do something wrong, try the keyboard shortcut: Ctrl+Z.

•

SAVING YOUR WORK - DON’T FORGET TO SAVE YOUR FILES: go to File > Save as... an .xcf (will save layers) or File > Export
as... a .jpg (flattens layers).

1. The Main Toolbox: Contains a set of icon buttons to
select tools. You can use Edit>Preferences>Toolbox to
enable, or disable the extra items.
2. Tool Options: Shows options for the currently
selected tool (in this case, the Move tool).
3. Image Windows: Shows the image that you open in
GIMP. You can display multiple images at the same
time.
4. Layers, Channels, Paths, Undo History Dock: They
are shown as tabs. The layers tab shows the layer
structure of the currently active image, allowing it to
be manipulated in different ways.

Basic arrangement of GIMP Windows (multiple-window mode)
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5. Brushes/Patterns/Gradients: Shows the dialogs
(tabs) for manging brushes, patterns and gradients.
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Work with images: separating an object from its background

Sometimes you need to separate the subject of an image from its background, and use it on an existing
background. To do this:
1. Select the object using the following tools:
Free Select Tool that allows you to
create a selection by drawing the
boundary free-hand with the pointer.

Intelligent Scissors Select Tool that
uses edge-recognition algorithms to
better fit the border around the object.

Foreground Select Tool that lets you
mark areas as “Foreground” or “Background”
and refines the selection automatically.

2. Once you have selected your subject successfully, use Select > Invert. Now, instead of the subject, the
background is selected.
3. Use Layer > Transparence > Add Alpha Channel to add an alpha channel. Next, use Edit Clear or hit the Del
key on the keyboard to remove the background. Please note that only a small subset of file formats support
transparent areas. Your best bet is to save your image as PNG.

Work with images: combining elements from more than one
image
Using the Clone tool, adjust opacity, brush
type and size, and then while holding the Ctrl
key, sample part of an image, then clone it to
a different part of the image.

Detail Setting of the Clone Tool

Open a new image and duplicate the layer
(right-click > duplicate). Drag the layer into the
first image.
Under Image > Canvas Size, double the canvas
size, and then move the new layer to the side.
Clone stamp elements of one layer over the
other.

The Clone Tool in the
Main Toolbox

Want to learn more tools and functions of GIMP, please check GIMP
User Manual at https://docs.gimp.org/en/index.html
calp.forestry.ubc.ca/
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PICTURE REFERENCES:
Eastern Redbud
•

https://commons.wikimedia.org/wiki/File:2013-05-16_09_38_27_Eastern_Redbud_along_Terrace_Boulevard_in_Ewing_
Township,_New_Jersey.jpg

•

Flowers: https://www.flickr.com/photos/frted/4506145671

•

Leaves: https://commons.wikimedia.org/wiki/File:A18-2-Cercis_Canadensis_(Eastern_Redbud).JPG

japanese snowbell
•

http://plants.meadowsfarms.com/Content/Images/Photos/F833-21.jpg

•

New leaves: https://classconnection.s3.amazonaws.com/516/flashcards/423516
jpg/styrax_japonica_i2870p952861310092516080.jpg

•

Flowers: http://www.missouribotanicalgarden.org/PlantFinder/FullImageDisplay.aspx?documentid=8934

European Hornbeam
•

https://www.flickr.com/photos/wlcutler/2557085953 at Vancouver Thurlow

•

New leaves: https://pixabay.com/en/carpinus-betulus-european-hornbeam-846553/

•

Golden leaves: https://pixabay.com/en/foliage-beech-leaves-fall-539413/

Garry Oak
•

https://www.flickr.com/photos/iangbl/751184866

•

Leaves: brewbooks https://www.flickr.com/photos/brewbooks/178394483

•

Flowers: https://www.flickr.com/photos/syeo/3436583864

Honey Locust
•

https://commons.wikimedia.org/wiki/File:Gleditsia_triacanthos_Maryhill_Museum_01.jpg

•

Flowers: https://commons.wikimedia.org/wiki/File:Gleditsia_triacanthos_in_Donetsk_3.jpg

•

Leaves: https://www.flickr.com/photos/sloanpix/2962833007

Rain barrel
•

By Benoit Rochon - Own work, CC BY 3.0, https://commons.wikimedia.org/w/index.php?curid=25920021

Micro Clover
•

Lawn: Grow Green Guide: http://www.growgreenguide.ca/

Nootka rose
•

Leaf: The Wild Garden, CC by 3.0, Photo credit: The Wild Garden, www.nwplants.com

•

Flower: The Wild Garden, CC by 3.0, Photo credit: The Wild Garden, www.nwplants.com

Red elderberry
•

Flowers: Tree Frog Farms - http://www.treefrogfarm.com/store/images/source/IFE_Q-Z/Red_Elderberry.jpg

•

Berries: Brian Klinkenberg on E-flora - http://linnet.geog.ubc.ca/ShowDBImage/ShowStandard.aspx?index=14310

Salmonberry
•

Berry: Brian Klinkenberg on E-flora - http://linnet.geog.ubc.ca/ShowDBImage/ShowStandard.aspx?index=21658

•

Flower: Gerald Carter - http://www.suresoft.ca/G026/G26I.HTM
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PICTURE REFERENCES:
Red-osier dogwood
•

Bark: UBC Botanical Garden - http://www.growgreenguide.ca/plants/red-twig

•

Flower: Curtis Clark - https://upload.wikimedia.org/wikipedia/commons/e/e4/Cornus_sericea_leaves_and_inflorescence_2003-08-11.jpg

False Lily of the Valley
•

Plant: Walter Siegmund - https://commons.wikimedia.org/wiki/File:Maianthemum_dilatatum_11112.JPG

•

Berries: Dgies - https://commons.wikimedia.org/wiki/File:Snakeberries.JPG

Morning glory (bindweed)
•

Structure: Brian Klinkenberg - http://linnet.geog.ubc.ca/ShowDBImage/ShowStandard.aspx?index=21665

•

Flower and leaf: Hardyplants, CC0 1.0 - https://commons.wikimedia.org/wiki/File:Calystegia_sepium_flower.jpg

English holly
•

Plant: Invasive Species Council of BC - http://bcinvasives.ca/invasive-species/identify/invasive-plants/english-holly

•

Leaves and berries: Invasive Species Council of BC - http://bcinvasives.ca/invasive-species/identify/invasive-plants/english-holly

English ivy
•

Leaves (subset) Brian Klinkenberg - http://linnet.geog.ubc.ca/ShowDBImage/ShowStandard.aspx?index=14929

•

Leaves: Missouri Botanical Gardens - http://www.missouribotanicalgarden.org/PlantFinder/FullImageDisplay.aspx?documentid=66811

Himalayan blackberry
•

Leaf: Brian Klinkenberg - http://linnet.geog.ubc.ca/ShowDBImage/ShowStandard.aspx?index=21134

•

Plant and flowers: Oregon State University, 1999-2015 - https://oregonstate.edu/dept/ldplants/rudis7.htm

Renewable energy
•

The earth (page 9): http://blog.cleanenergy.org/2014/10/17/epa-clean-power-plan-underestimates-power-of-renewable-energy-to-reduce-carbon-emissions/

•

Renewable energy icon (page 9): https://www.vexels.com/vectors/preview/77950/green-energy-tree-icons

•

Vancouver energy composition (page 10): http://vancouver.ca/files/cov/renewable-city-strategy-booklet-2015.pdf

•

Basic retrofit (page 55): http://142.103.31.10:5000/energy101/energy101-3#page4

•

House retrofit design (page 56): http://metalaccord.com/efficient-home-design/efficient-home-design-energy-efficient-homes-design-home-design-ideas-creative

•

Home energy costs (page 60): http://metalaccord.com/efficient-home-design/efficient-home-design-energy-efficienthomes-design-home-design-ideas-best-model-2
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